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Presentations 

 

 

Tomorrow you have two appointments: a visit to the dentist, 
and a presentation to an audience of strangers and friends. 

Which one fills you with greater terror? 

Whether it’s to a group of potential customers, a national 
conference of fellow workers, or a local community group, 
delivering an address can be an intimidating prospect. 

Faced with these situations, you'll want to learn about any 
tools that will help you to feel less pressurised and more 
organised – tools that will make you more confident and help 
you make your points more effectively. This is where 
presentation software comes in. 

In this Module, you will discover how to create support 
materials that will reinforce your message, both textually 
and graphically. You will also find out how to design your 
materials – both on-screen slides and paper hand-outs – so 
as to maximise their audience impact. 

Software won’t turn a bad presentation into a good one. But 
it can help a good presentation succeed in its aim: better 
communication of your bright ideas. 

Think of this Module as your chance to speak rather than be 
spoken to. Good luck with it. 

6 
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Section 6.1: Presentation Basics 

 

This Section deals with the basic concepts of presentation 
software, introduces you to the terminology you will need, and lets 
you sample the possibilities on offer. 

 

At the end of this Section, you should be able to: 

■ Explain what presentation software is used for 

■ Start and quit PowerPoint 

■ Open and close a presentation 

■ Show a PowerPoint presentation on your computer 

■ View the presentation in a variety of ways 

■ Print out a PowerPoint presentation – as OHPs, handouts, or 
35mm slides 

■ Use PowerPoint’s online help facilities 

■ Modify PowerPoint’s toolbar display 

 

At the end of this Section you should be able to explain the 
following terms: 

■ Presentation 

■ Slide 

■ Normal View 

■ Outline View 

■ Slide Sorter View 

■ Notes Page View 

■ Slide Show View 

■ OHP 

In This Section 

New Activities 

New Words 
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When you demonstrate a new product, describe the results of your 
research, or announce a new organisational structure, you typically 
make a speech. To grab your audience’s attention, and reinforce 
your messages, you show them a variety of visual aids while you 
are talking. To ensure they retain key information, you give them 
handouts to take away and study afterwards. That’s a presentation.  

Presentation software helps you design and produce the visual aids 
and the handouts. Unfortunately, it doesn’t help you with the 
speech, but it does help you to organise your thoughts, and it helps 
ensure that questions and comments from the audience don’t put 
you off course. For the ECDL, you have to know how to produce 
the visual aids and handouts; you don’t have to make a speech. 
Phew! 

The visual aids reinforce and complement what you say – they 
shouldn’t duplicate it. They should include images wherever 
possible (pictures, graphs, charts, maps, cartoons, diagrams). Text 
should be kept to a minimum, using headline style and bullet 
points.  

The visual aids can be printed on paper or on overhead projection 
foils (OHP), they can be output to 35mm transparencies (slides), 
they can displayed directly on the computer screen, or they can be 
projected from the computer using a directly-connected projector. 
The choice of output depends on the number of people in your 
audience, the size of the room in which you are making the 
presentation, and the technology available.  

Although 35mm slides are probably the least common form of 
output, most presentation software packages call the basic element 
of a presentation a `slide’. 

Slide 
A slide is the basic building block of a visual presentation. It is 
equivalent to a page in a printed document; it can contain both text 
and graphics. 

 

Double-click on the PowerPoint icon. 

-or-  

Choose Start | Programs | PowerPoint. 

Presentations and 
Presentation 
Software 

Starting 
PowerPoint 
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The file names of PowerPoint files end in .ppt, .pps, or .pot. (Each 
of these is used for different purposes, as you will see later.) This 
helps you to distinguish them from Word documents (.doc), Excel 
workbooks (.xls), and other file types. 

To open an existing presentation, either: 

■ Select Open an Existing Presentation on the first dialog box 
displayed when you start PowerPoint 

-or- 

■ (If you have already been working in PowerPoint) Choose File 
| Open (or click the Open button on the Standard Toolbar). 

Then select the file you want from the dialog box. 

Exercise 6.1: Opening a Presentation 
To experiment in this Section, open Dale Carnegie’s Presenting a 
Technical Report: 

1) Choose File | New. 

2) Click on the Presentations Tab, select Presenting a Technical Report and 
click OK. 

 

PowerPoint enables you to look at the same material in a variety of 
different formats, to view individual slides, and to print out the 
presentation. 

Opening an Existing 
Presentation 

Working With 
PowerPoint 
Presentations 

Open button 
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The different viewing options are available from the View menu. 

■ Normal view contains three panes: the outline pane, the slide 
pane, and the notes pane. These panes let you work on all 
aspects of your presentation in one place. You can adjust the 
size of the different panes by dragging the pane borders. 

■ Slide Sorter shows a miniature version of the entire slide 
show. You can use this to check the consistency of the layout 
and colour scheme, and also to check, and if necessary change, 
the order of the slides. 

■ Notes Page shows the slides one at a time, half-sized, with a 
space below for speaker’s notes. 

■ Slide Show shows the slides full-screen (without any menu 
bars), exactly as they would appear projected. To exit from 
Slide Show view, press the Esc key.  

At the bottom left of the screen (except in Slide Show view), there 
are two additional options. 

■ Outline shows the text of all the slides, without formatting or 
graphics. It is most useful when you are organising your 
thoughts, or for checking or changing the overall structure of 
the presentation. 

■ Slide lets you see one slide at a time. This is the normal 
viewing mode when you are creating a presentation: you are 
able to see what the finished product will look like, and you are 
able to edit the text, add graphics, and so on.. 

 

Use these five icons, representing the five viewing modes, to 
switch quickly from one mode to another. 

 

 

 

 

 

 

 

 

Different Views 

Slide View       

Outline View              Slide Sorter View 

Normal View Slide Show 
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The View menu also offers a Zoom 
option: use this to enlarge or 
reduce the slide shown on the 
screen.  

 

 

 

 

Certain navigation keys can be used in all PowerPoint views: 

To advance to the next slide  Press Page Down 

To return to the previous slide  Press Page Up 

To go to the first slide in the show Press Home 

To go to the last slide Press End 

In all views except Slide Show view, you can also use the scroll 
bar at the right of the screen to move forwards or backwards.  

In Slide Show View, a wider range of options is available: 

To advance to the next slide Left mouse click 
Spacebar 
N 
Right arrow 
Down arrow 
ENTER 
Page Down 

To return to the previous slide BACKSPACE 
P 
Left arrow 
Up arrow 
Page Up 

To go to a particular slide Type the number of the slide,  
and press ENTER 

To go to the first slide in the show Hold down both mouse buttons 
for two seconds 

To blank out the screen  B (for black) 
W (for white) 

To return to the presentation B or 
W again 

 

Zoom 

Finding Your Way 
Around a Presentation 
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If you forget any of these controls, don’t worry: press F1 any time 
during a presentation and the full list of controls is displayed. 

Exercise 6.2: Exercises in Navigation 
1) Open Dale Carnegie’s presentation from Exercise 6.1. 

2) In Slide View, go back and forth through the presentation, one slide at a 
time, using the keyboard. 

3) In Slide Show view, go back and forth through the presentation, one 
slide at a time, using the mouse wherever possible. 

4) Go to slide 4. What two Tips are given on that slide? 

 

You can print out a PowerPoint presentation in a variety of ways, 
depending on your requirements and on the hardware at your 
disposal. Printing in PowerPoint is similar to printing in other 
applications: 

First, choose File | Print, or click the print button in the button bar. 
Then, in the Print What drop-down box, you can choose to print 
slides, outline, speaker notes, or handouts. If you choose handouts, 
you can choose the number of slides per handout. 

 

You can then specify, in the Print range area of the dialog box, 
whether you want to print all slides, the current slide, or a selected 
range of slides. To print a contiguous range of slides, type the 
number of the first slide, a hyphen, and the number of the last 
slide. To print non-contiguous slides, type the individual slide 
numbers separated by commas. 

 

Printing a Presentation 

Print button 
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If you wish to produce overhead projection foils (OHPs), you need 
to load your printer with blank foils before clicking OK on the 
Print dialog. 

If you wish to produce 35mm slides, you need to have a special 
desktop film recorder connected to your computer.  

Exercise 6.3: Exercises in Printing  
1) Print a set of handouts for the entire presentation with six slides on 

each page. 

2) Print the first three slides of the presentation. 

3) Print the first and fourth slide of the presentation. 

 

By default, when you first choose a menu, PowerPoint displays 
only some of the commands on that menu. To view a complete list, 
click the double-arrow at the bottom of the menu. 

If you choose a command that is not displayed by default, 
PowerPoint adds it to the displayed list the next time you choose 
the menu. 

To view all commands each time you choose a menu, follow these 
steps: 

• Choose Tools | Customize and click the Options tab. 

• Deselect the Menus show recently used commands first 
option, and choose Close. 

 
 
 

The online help built into PowerPoint provides additional 
information to help you use the various features and to get the 
most from the software. To use it, click Help | Microsoft 
PowerPoint Help and choose the Index tab. Either type the word 
you are looking for or scroll down to find a keyword. A list of 
topics is then shown: click on the one that most closely matches 
your interest. 

PowerPoint's 
Personalised 
Menus 

Using Online Help 

Click the double-arrow to 
display all menu commands 
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You can also get help by clicking the Office Assistant button, or (if 
PowerPoint is set up this way) by pressing the F1 key. 

 

You should familiarise yourself with the online help facility: 
remember, you can use it while you are doing your ECDL test. 

Office Assistant 
button 
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The options in the Menu Bar give you 
access to all of PowerPoint’s features. 
However, it is easier and quicker to 
select a feature by clicking a single 
button – and buttons may be displayed in 
a Button Bar or Toolbar.  

In PowerPoint, you can display a 
number of different Toolbars, each 
covering a different range of functions. 
Click View | Toolbars. If they are not 
already displayed, check Standard, 
Formatting, and Drawing. These will be 
the most useful for your work in this 
Module.  

 

To close the presentation, choose File | Close or click the Close 
button on the presentation window. 

 

If you have made changes to the presentation since you last saved 
it, PowerPoint prompts you to save the changes before it closes the 
file. 

 

To leave PowerPoint, choose File | Exit or click the Close button 
on the PowerPoint window. 

If you have left open any files containing unsaved work, 
PowerPoint prompts you to save them. You are then returned to 
the Windows desktop. 

Modifying the Toolbar 
Display 

Closing a 
Presentation 

Quitting 
PowerPoint 

Presentation Close button 

PowerPoint Close button 
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A presentation is an address to an audience, accompanied by 
visual aids, such as slides or overhead projection foils (OHPs), and 
possibly handouts for the audience.  

Presentation software, such as PowerPoint, helps you prepare all 
the support materials for a presentation. 

The basic building blocks of a presentation are called slides.  

While you are working with PowerPoint, you can view your slides 
in six ways – Normal View, Outline View, Slide View, Slide Sorter 
View, Slide Show View and Notes Page View. Slide Show View is 
what the audience sees when you are making the presentation. 

You can move around a presentation using the Page Up and Page 
Down keys. Other options are available in Slide Show View. 

You can print out your presentation materials in a variety of ways. 

PowerPoint includes a built-in help facility that contains reference 
material on all the software’s functions, and many helpful tips for 
creating convincing presentations. 

You can modify the toolbar display so that the features you use 
most often are readily available. 

Section Summary: 
So Now You Know 
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Section 6.2: Creating Your First Slides 

In this Section, you will learn how to use PowerPoint to create 
simple text-based slides.  

 

At the end of this Section, you should be able to: 

■ Create a new, text-based slide 

■ Enter, edit, and delete text in a slide 

■ Import text and other objects into a PowerPoint slide 

■ Delete objects from a slide 

■ Delete a slide 

■ Save a presentation to hard disk or diskette 

 

At the end of this Section you should be able to explain the 
following terms: 

■ Placeholder 

■ AutoLayout 

■ Portrait 

■ Landscape 

In This Section 

New Skills 

New Words 
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To create a new presentation: 

If you have already been using PowerPoint and it is still open: 

■ Choose File | New. Click on General, select the Blank 
Presentation icon, and click OK.  

■ Click the New button on the Standard Toolbar.  

■ Or, start PowerPoint by double-clicking on the PowerPoint 
icon or by choosing Start | Programs | PowerPoint. Click the 
Blank Presentation button and click OK. 

 

All the exercises in this Section contribute to creating the new 
presentation. 

Exercise 6.4: Using the Placeholders to Enter Text 
1) When you create a new presentation, PowerPoint displays a dialog box 

that offers a choice of ready-made layouts (called AutoLayouts) for 
your slides. As you click on a layout, PowerPoint shows the name of 
that layout in an area at the right of the dialog box. 

Select the first layout, which PowerPoint calls Title Slide, and click 
OK.  

2) You are now shown a 
screen that contains two 
boxes surrounded by dotted 
lines. PowerPoint calls 
these boxes placeholders.  

Click on the top 
placeholder. 

Creating a New 
Presentation 

New button 
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3) The border of the placeholder changes and a blinking text cursor 
appears inside it. You can now type text in the placeholder. 

Enter the following text in the first placeholder: 

New Product Launch 

4) Click on the second 
placeholder and enter the 
following text: 

Round Wheels 

Your screen should now 
look like that shown on 
the right. 

 

Congratulations! You have created the first slide of your first 
presentation in PowerPoint. 

You can add, edit or delete text to a slide in any PowerPoint view, 
with the exception of Slide Show. Simply position the cursor 
where you want to make the changes and edit.  

AutoLayout 
One of 24 ready-made slide layouts. They typically include 
placeholders for text and other objects, such as images and charts. 

Placeholder 
A frame or box within a slide for holding text or graphics. 

Remember:  

■ Click on a placeholder to select it so that you can type or edit 
text. 

■ Click outside the placeholder to deselect it. 

 

Most cinema screens, television screens and computer screens are 
wider than they are tall: so will most of your slide presentations. 
This format is known as landscape; the alternative (taller) is 
known as portrait. If you ever want to produce a presentation in 
portrait format, choose File | Page Setup, and under Orientation, 
Slides, click Portrait. 

Landscape or Portrait? 
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After the title slide, you will want to create further slides to hold 
the main body of your presentation. Do this as follows: 

Exercise 6.5: Adding Slides to a Presentation 
1) Choose Insert | New Slide or click the New Slide button on the 

Standard Toolbar. 

2) Select the slide layout you want to use. 

This time, select the Bulleted List. 

 

3) Click on the first placeholder and type: Amazing Features 

4) Click on the second placeholder and type: Smooth Travelling for 
Passenger Comfort 

5) Press ENTER. PowerPoint creates a second bullet point on a new line. 
Type: Reduced Fuel Consumption 

6) Press ENTER. Continue to enter the features as shown below. Use the 
Demote button to create the second level of bullet for the different 
modes of transport. (Use the Promote button to elevate them to the 
first level.) 

 

Well done! That’s two slides created already. 

Adding Slides to 
Your Presentation 

New Slide 
button 

Demote 

Promote 
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Perhaps the best way to organise your ideas is to use Outline view. 
This enables you to see the text of all your slides, arranged like a 
table of contents. In Outline view, you can add, edit, and delete 
text. You can also change the order of the slides, and arrange the 
text so that the more important text is made more prominent.  

Outline View 
Shows the text of all your slides, so that you can judge how well 
your ideas and text flow from one slide to the next. 

To see your presentation in Outline view, choose View | Outline, 
or click the Outline View button. 

You can use the buttons on the Outlining Toolbar to move slides or 
text, show only slide titles, and change the indent level of titles and 
text. Try it. 

 

Exercise 6.6: Using Outline View to Add Slides  
1) When you open Outline View, you see the text of the slides you have 

created so far. Click at the end of the text and press ENTER. 

 

Using Outline View 

Outline View 
button 
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2) Type the headline for the next slide: Advantages and Disadvantages. 
Notice that the text takes on the attributes of the previous line of text: it 
appears as a minor bullet on slide number 2.  

3) Correct the status of the headline by using the Promote button on the 
toolbar. Notice that when it reaches the top of the hierarchy (that is, 
when you have promoted it as far as you can), it is automatically 
assigned a slide number (3). 

4) Add the text of the first advantage: Faster. Press ENTER. Notice once 
again that the new text takes on the attributes of the previous line of 
text: it appears as a separate slide. Use the Demote button to establish 
it as a subordinate point. Then add the remaining advantages and 
disadvantages, as shown below. 

 

5) Add four more slides, with text as shown below. Note that the last 
three contain only a headline. 

 

6) Click the Slide View button, or choose View | Slide. Move forward and 
back through the slides (using any of the methods described in the 
previous Section) to see the effect of your work. 

7) Click the Slide Show button, or choose View | Slide Show. Again, 
move forward and back through the presentation to see how it would 
look to the audience. 

By now you should realise that you can create an acceptable 
PowerPoint presentation very quickly. 

Notice that PowerPoint assumes that some of the slides will have 
more text added later, and has created placeholders for that text. 

Slide View 
button 

Slide Show 
button 
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(The placeholder text (‘Click to add text’ etc.) is not displayed in 
Slide Show view.) 

 

To copy text from one slide to another, or from one part of a slide 
to another, select the text by clicking and dragging, then choose 
Edit | Copy (or hold down the CTRL key and press c). Then 
position your cursor where you want the text to appear and choose 
Edit | Paste (or hold down the CTRL key and press v). 

Exercise 6.7: Moving Text within PowerPoint 
1) Open slide number 3 (Advantages & Disadvantages) in Slide View. 

2) Choose Format | Slide Layout, and  
select the Two Column Text layout.  

Click Apply. 

3) Select the last three bulleted points.  

4) Choose Edit | Cut.  

5) Click in the right-hand 
text placeholder.  

6) Choose Edit | Paste.  

7) The three ‘disadvantage’ 
points are moved into 
position. 

 
 

If you have text in another application, such as Microsoft Word, 
you can use that text in PowerPoint without having to retype it. 
The simplest way is to select the text in the other application, 
choose Edit | Copy (or hold down the CTRL key and press c), and 
then, in PowerPoint, position your cursor where you want the text 
to appear and choose Edit | Paste (or hold down the CTRL key 
and press v). You can paste the text in any PowerPoint view except 
Slide Show. 

You can also open a Word file in PowerPoint. Choose File | Open, 
select the file you are interested in, and click Open. PowerPoint 
tries to guess how you want the text treated: if you have not done 
any formatting in Word, it treats each paragraph as a separate slide. 
If you have used Word paragraph formats or tabs, PowerPoint 
interprets these as best it can. In any case, you can rearrange and 
reformat the text, as shown above. 

This exercise shows the copy-and-paste technique. 

Copying Text within 
PowerPoint 

Importing Text from 
Another Application 
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Exercise 6.8: Copying Text from Another Application 
1) Choose Help | Microsoft PowerPoint Help, choose the Index tab and 

type the word ‘import’. A list of topics is then shown: click on ‘About 
importing text from other programs'. 

 

2) Select the first sentence of text in the help page. 

 

Choose Edit | Copy. Close the Help dialog box. 

3) In PowerPoint, select Outline View. Position the cursor at the end of 
slide number 6 (Sales Projections).  

Press ENTER (to create a new, blank slide). 

4) Choose Edit | Paste.  

 

The sentence from the help text appears as slide number 7. 

5) Use the Demote button to make the text part of slide number 6.  
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Undo     Redo 

 

Notice how the final slide is renumbered to take account of the 
change.  

You can use the same technique to copy objects from other 
applications: for example, you can select a range of cells in an 
Excel worksheet, copy them (as above), and paste them into a 
PowerPoint slide. Or you can copy a chart created in Excel, or a 
table created in Word, or a graphic file (such as a scanned image) 
from a graphics program. 

 

To delete a slide, position the cursor anywhere in the slide and 
choose Edit | Delete Slide. You can do this in any view except 
Slide Show view. 

Exercise 6.9: Deleting a Slide 
Delete slide number 5 (Sales & Marketing) from your presentation. 

 

Enter the wrong text? Press the wrong key? Delete something you 
didn’t mean to? PowerPoint allows you undo your most recent 
actions if they have produced unwanted results. Choose Edit | 
Undo or click the Undo button on the Standard Toolbar. You can 
also Redo actions that you have undone: choose Edit | Redo or 
click the Redo button on the Toolbar. 

Exercise 6.10: Using Undo 
1) Choose Edit | Undo. The presentation reverts to the condition it was in 

before your most recent action.  

2) Repeat undoing until the presentation is in the condition it was in before 
Exercise 6.8. 

 

To save your presentation, choose File | Save or click the Save 
button on the Standard Toolbar. As in all programs, you must 
name your presentation and specify where it is to be saved when 
you save it for the first time. 

Choose File | Save As to save a presentation under a different 
name or in a different location.  

Deleting a Slide 

PowerPoint's 
Undo Feature 

Saving Your 
Presentation 

Save button 



 

ECDL 3: The Complete Coursebook  6-21 

Exercise 6.11: Saving Your Presentation to Hard Disk or 
Diskette 
1) Save the presentation that you have created in this Section. Give it a 

name that you will find easy to remember and recognise. For example, 
if your initials are KB, call it KBpres1. 

 

2) Save the presentation again, this time on diskette. To do this, you will 
need to click the Up One Level button repeatedly until you are the My 
Computer level. Then insert a diskette in the diskette drive, click the 
icon for the A: drive, and click Save. 

 
 

To create a new slide, you choose an AutoLayout that most closely 
matches your needs.  

AutoLayouts contain placeholders in which you enter the text. 

Alternatively, you can import from another source, such as a word 
processor. 

You can use Outline view to collect and organise your ideas, 
without worrying too much about formatting and style. 

If you make changes that you don’t like, you can Undo them. And 
you can save your presentation to hard disk or diskette. 

PowerPoint presentations have the extension .ppt, .pps, or .pot. 

 

Section Summary: 
So Now You Know 

Up One Level 
button 
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Section 6.3: Adding Graphics and Pictures 

In this Section, you will learn how to include pictures and other 
graphics in your slides. 

 

At the end of this Section, you should be able to: 

■ Add simple graphic devices (lines, boxes, etc.) to a slide 

■ Edit and delete graphic devices 

■ Create and modify organisation charts, bar charts, and pie 
charts and include them in a presentation. 

■ Import a photograph or clip art image to a slide 

■ Copy and paste images (within the presentation, between 
different presentations, and between PowerPoint and another 
application) 

■ Move, change the size and shape, rotate, and flip objects in a 
slide 

 

At the end of this Section you should be able to explain the 
following terms: 

■ AutoShapes 

■ Organisation Chart 

■ Clip Art 

The exercises in this Section further develop the presentation 
created in Section 6.2. Open the presentation before beginning the 
exercises in this Section. 

In This Section 

New Skills 

New Words 
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The Drawing Toolbar includes a number of tools for drawing 
simple objects, including lines, arrows, rectangles, and ellipses. 

 

 
 

To draw a line, click on the Line button, place the cursor where 
you want the line to begin, click and drag to where you want the 
line to end, and release the mouse button.  

To draw an arrow, click on the Arrow button and draw it in the 
same way.  

Change the style of arrowhead, or the direction of the arrow, by 
clicking the Arrow Style Button.  

 

To draw a rectangle, click on the Rectangle button, place the 
cursor where you want one corner of the rectangle, click and drag 
diagonally to where you want the opposite corner of the rectangle, 
and release the mouse button. 

To draw a square, hold down the SHIFT key as you drag with the 
mouse. 

 

To draw an ellipse, click on the Ellipse button, place the cursor 
where you want the shape to begin, click and drag until the shape 
it is the size you want, and release the mouse button.  

To draw a circle, hold down the SHIFT key as you drag with the 
mouse. 

 

In the case of straight lines, arrows, rectangles, and ellipses, you 
can specify the colour and thickness of the line. Click on the Line 
Colour button and select a colour, either before you draw the line, 
or, with the line selected, after you have drawn it.  

Change the thickness of the line by clicking the Line Style button.  

Make the line a dashed line (in a choice of dash styles) by clicking 
the Dash Style button. 

Using PowerPoint’s 
Drawing Tools 

Line and Arrow Tools  

Rectangle Tool 

Ellipse Tool 

Line Colour and Style 
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Use this button to choose the colour 
with which the inside of the rectangle 
or ellipse should be filled. Note that the 
choice of colours pops up when you 
click the arrow. Again, you can choose 
the fill colour before you draw the 
shape, or you can select an existing 
shape and then choose a fill colour. 

 

A Text Box is an alternative means of adding text to a slide. Add a 
text box to a slide in the same way as you add a rectangle. Then 
type text into it. Change the format of the text by selecting it and 
then choosing options from the Format menu (in particular, Font, 
Bullet, and Alignment. Note, however, that text added to a slide 
using Text Box does not appear in Outline View.  

 

To change the shape or size of any object created with the drawing 
tools, click on the object to select it. A number of sizing handles 
are shown around the object. Click on any of these and drag the 
handle until the object is the required shape and size.  

 

To change position of any object created with the drawing tools, 
click on the object to select it. Click on the object anywhere except 
on a sizing handle. The cursor changes to a cross-hair shape. Drag 
the object to the desired new location. 

To move an object between slides, use the Cut and Paste 
commands on the Edit menu. 

To rotate any object 
created with the drawing 
tools by 90° in either 
direction, click on the 
object to select it. On the 
Drawing Toolbar, click on 
Draw and from the pop-
up menu choose Rotate or 
Flip. Then choose Rotate  
Left or Rotate Right. The  
object changes its orientation  
immediately. 

Fill Colour 

Text Box 

Editing Drawn Objects 

Repositioning 
cursor shape 



 

ECDL 3: The Complete Coursebook  6-25 

Similarly, to flip any object created with the drawing tools, click 
on the object to select it, click on the Draw menu and from the 
pop-up choose Rotate or Flip. Then choose Flip Horizontal or 
Flip Vertical. The object changes its orientation immediately. 

To rotate an object freely, click on the object 
to select it. Then click on the Free Rotate 
button. The sizing handles are replaced by 
rotating handles. Click on any of these (the 
cursor changes to a shape), and drag the 
object to its new orientation. You can limit 
the object’s rotation to 15° steps by holding 
down the SHIFT key as you drag with the mouse. 

To delete any object created with the drawing tools, click on the 
object to select it and press Delete. 

Exercise 6.12: Drawing Shapes 
1) Open slide number 7 (Product Identity Scheme) in Slide View. 

2) We do not want the placeholder:  
choose Format | Slide Layout, and select 
 the Title Only layout. Click Apply. 

3) Draw three circles, as shown below. The two bigger circles have a line 
thickness of 6 points; the smallest circle has a line thickness of 3 
points. All circles are red, with blue fill. 

4) Add a text box to the right of the circles. Add text as shown. Make the 
text Arial bold, 24 point. Make it bulleted and put a space line between 
each point. 

 

5) Save the presentation. 

Free Rotating 
Cursor Shape 
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You can group objects so that you can work with them as if they 
were a single object. You can format, move, rotate, flip and resize 
grouped objects in a single operation. 

To group objects, hold down SHIFT and click each of the objects 
in turn. Next, click the Draw button on the Drawing Toolbar and 
choose the Group command. 

To ungroup a selected group of objects, click the Draw button on 
the Drawing Toolbar and choose the Ungroup command. 

 

AutoShapes are commonly-used, ready-made shapes that you can 
insert in your presentations. They include lines, basic shapes, 
flowchart elements, stars and banners, and callouts. 

When you insert an  
AutoShape on a slide, you  
can change its size and  
colour, and rotate it, as  
required. 

To select an AutoShape,  
click the AutoShapes button  
on the Drawing Toolbar  
and choose from the options 
offered by the pop-up menu. 

 

AutoShapes 
Ready-made shapes, including lines, geometric shapes and 
flowchart elements that you can use in your presentations.  

 

Organisation charts are used to illustrate hierarchical organisations 
or structures. People or units in an organisation are represented by 
boxes, and their relationships are represented by lines. You could 
draw them using the drawing tools, but they are used so frequently 
that PowerPoint provides a tool especially for producing them. 

Organisation Chart 
A diagram used to illustrate the people or units in an organisation 
(represented by boxes) and their relationships (represented by 
lines). 

Grouping and 
Ungrouping Objects 

Inserting 
AutoShapes 

Inserting 
Organisation Charts 
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To include an organisation chart in a slide:  

■ Start with a blank slide, or one with only a title, and choose 
Insert | Picture | Organisation Chart. 

-or- 

■ Choose Format | Slide Layout, and select the 
Organisation Chart layout. Click Apply. Then 
double-click on the organisation chart icon. 

-or- 

■ Choose Insert | New Slide, and select the 
Organisation Chart layout. Click OK. Then 
double-click on the organisation chart icon. 

PowerPoint opens a new window that displays an organisation 
chart template and offers new menus of commands. The Styles 
menu, for example, allows you to choose different chart types, 
while the Text, Boxes and Lines menus each allow you format the 
respective chart elements. 

You can alter the template as you wish. Although the boxes have 
text labels in them, such as `Type name here’, you can enter any 
type of information in any box – the labels are for your guidance 
only. 

 

Exercise 6.13: Inserting an Organisation Chart 
1) Open slide number 5 (Sales and Marketing) in Slide View. 

2) Choose Format | Slide Layout, and select the Organisation Chart 
layout. 

Click Apply. 
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3) Double-click on the organisation chart icon to open the Organisation 
Chart window. 

4) Edit the text in the template as shown below. 

 

5) When you have finished working in the Organisation Chart window, 
return to your slide by choosing File | Exit and Return to, and then 
clicking Yes on the dialog box displayed. 

Within PowerPoint, you can move, resize or delete a chart as you 
would any other object. To make any other changes to the chart, 
however, you have to double-click on the chart and make your 
changes in the Organisation Chart window. 

Exercise 6.14: Modifying the Structure of an Organisation 
Chart 
1) Open slide number 5 (Sales and Marketing) in Slide View. Double-click 

on the organisation chart. 

2) The chart is opened in the Organisation Chart window. The toolbar 
provides buttons for adding boxes (Subordinates, Co-workers, 
Managers, Assistants) and lines.  

Click the second Co-worker button. 

 

 

Next, click on the box containing Graham Horton. A new box is 
created, at the same level in the hierarchy, and the other chart 
elements are rearranged. 
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Click the new box, and enter text as shown below. 

 

3) Close the Organisation Chart window, and confirm that you want to 
update the chart in the presentation. 

 

In many circumstances, you will need to present quantitative data. 
This kind of information is often best presented in the form of 
graphs, or charts. Luckily, PowerPoint provides a facility for 
including a variety of chart types in your slides. 

To include a graph or a chart in a slide:  

■ Start with a blank slide, or one with only a title, and choose 
Insert | Chart. 

-or- 

■ Choose Format | Slide Layout, and select the 
Chart layout (or Text & Chart, or Chart & Text). 
Click Apply. Then double-click on the chart icon. 

-or- 

■ Choose Insert | New Slide, and select the  
Chart layout. Click OK. Then double-click on  
the chart button. 

PowerPoint inserts a model chart into the slide, and, in a separate 
window, presents a mini-datasheet showing the numbers and titles 
upon which the chart is based. 

Presenting 
Quantitative 
Information 
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By changing the numbers and titles, you change the underlying 
chart. You can add new rows and columns by entering data into 
the datasheet. Delete rows or columns by clicking on the letter at 
the top of the column or the number at the left of the row (the 
column/row changes colour) and pressing Delete. When you are 
finished, close the datasheet window. 

To change the colour or format of any element in the chart, 
double-click on it: you are presented with options that are relevant 
to that element. 

To change the data: 

■ Double click on the chart. The datasheet upon which the chart 
is based is shown. Click on this to make any changes.  

To change the chart type: 

■ Double click on the chart. Click the Chart  button on the 
toolbar and select Chart Type 

■ Select the chart type and sub-type from the menu. The most 
commonly used types are Column, Line, and Pie. 

• Column charts are typically used to show figures that are 
measured at a particular time 

• Line charts are typically used to illustrate trends over time 

• Pie charts are typically used to illustrate the breakdown of 
figures in a total. Note that a pie chart is based on a single 
column of numbers. 
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■ Click OK. 

PowerPoint gives you a wide variety of presentation options for 
charts. Some of them, however, are more decorative than 
informative: be careful that your message isn’t obscured.  

Exercise 6.15: Inserting a Chart 
1) Open slide number 6 (Sales Projections) in Slide View. 

2) Choose Format | Slide Layout, and select the Chart layout.  

Click Apply. 

3) Double-click on the chart icon to open the Datasheet window. 

4) Edit the text in the datasheet, as shown below. 

 

5) When you have finished working in the datasheet window, close it and 
you return to your slide. 

Within PowerPoint, you can move, resize or delete a chart as you 
would any other object. To make changes to the data in the chart, 
however, you have to double-click on the chart and make your 
changes in the Datasheet window. 
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You can also illustrate your slides by inserting graphic images – 
drawings created in other software applications, scanned 
photographs, or clip art. 

PowerPoint includes a gallery of clip art images that you can use 
in different presentations. They are grouped in categories, ranging 
from Academic to Food and Travel. 

Clip Art 
Standard or 'stock' images that can be used and reused in 
presentations and other documents. 

To include a picture in a slide:  

■ Start with a blank slide, or one with only a title, and choose 
Insert | Picture | Clip Art. 

-or- 

■ Choose Format | Slide Layout, and select the Clip 
Art & Text (or Text & Clip Art) layout. Click 
Apply. Double-click the clip art icon. 

-or- 

■ Choose Insert | New Slide, and select the Clip 
Art & Text layout. Click OK. Double-click the 
clip art icon. 

You are then presented with a gallery of images. 
Select the one you want to use, and click Insert. 

Importing Pictures 
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Exercise 6.16: Inserting a Clip Art Image 
1) Open slide number 4 (A First Look at the New Product) in Slide View. 

2) Choose Format | Slide Layout, and select the Clip Art & Text layout. 
Click Apply. 

3) Double-click on the clip art icon to open the Gallery. 

4) Search the Gallery for a suitable image. (Hint: try the Transportation 
category. The one in the example is from Shapes.) Click on the image 
and click on the Insert Clip button. 

 

The image is inserted into the slide.  

5) Choose View | Slide Show, or click the Slide Show button. Move 
forward and back through the presentation to see how it would look to 
the audience.  

6) Save the presentation. 

You can move, resize or delete the image as you would any other 
object.  

To change the colours, brightness, or contrast of the image, you 
need the Picture Toolbar. Either choose View | Toolbars | Picture, 
or right-click on the image and the Picture Toolbar appears.  
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Any changes you make are shown on screen. Click on the close 
box at the top right of the Picture Toolbar when you are finished. 

You are not restricted to inserting images on slides whose layout 
includes a graphic icon. You can insert a clip art image on any 
slide by choosing Insert | Picture | Clip Art. 

To insert an image of your own – your company logo, for example 
– choose Insert | Picture | From File, and select the required 
image file. PowerPoint accepts images in most common image file 
formats. 

You can also copy images from graphic programs and paste them 
into PowerPoint slides, as described in the previous Section. 

 

You can make objects in your slides appear to stand out from the 
background by adding a shadow to them. Select the object, then 
click the Shadow button on the Drawing toolbar. You can choose 
from a variety of shadow styles. Be careful, if you are choosing a 
colour for the shadow, that you do not interfere with the legibility 
of your text. 

Exercise 6.17: Adding a Shadow to an Object 
1) Open slide number 5 (Sales & Marketing) in Slide View. 

2) Select the chart by clicking anywhere on it. 

3) Click the Shadow button on the Drawing toolbar. Choose Shadow Style 
5. 

Standing Out from 
the Crowd 

Colour Contrast      Brightness 
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Click the Shadow button again.  

4) Click Shadow Settings, and in the Shadow Settings button bar, click the 
Shadow Color button, and pick a mid-blue as the shadow colour.  

 

Close the Shadow Settings button bar. 

5) Save the presentation.  
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You can draw simple shapes (lines, arrows, rectangles, ellipses) 
within PowerPoint. You can also add more complex shapes 
(AutoShapes) within PowerPoint. 

You can change the shape, size, position, and colour of such 
shapes, rotate them, flip them, and add shadows behind them. 

You can create organisation charts, and a range of graphs and 
charts to illustrate quantitative data. 

You can also import graphics created in other applications – charts, 
worksheets, tables, diagrams, pictures, photographs, maps, etc. 

 

Section Summary: 
So Now You Know 
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Section 6.4: Projecting a Consistent Image 

 

In this Section, you will learn how to choose an overall style for 
your presentation, how to pick a colour scheme, and how to 
establish a coherent typographic style. These are important if your 
presentation is to convey a strong, confident image. If each of your 
slides looks entirely different, your message will appear confused 
and disjointed. 

 

At the end of this Section, you should be able to: 

■ Choose an overall design for your presentation 

■ Select and modify a colour scheme 

■ Select and modify a background for your slides 

■ Use master slides to control the consistency of your slides 

■ Change the text attributes of individual slides 

■ Save a presentation as a template for subsequent use 

 

At the end of this Section you should be able to explain the 
following terms: 

■ Presentation Design 

■ Colour Scheme 

■ Slide Master 

■ Presentation Template 

The exercises in this Section further develop the presentation 
created in Sections 6.2 and 6.3. Open the presentation before 
beginning the exercises in this Section. 

In This Section 

New Skills 

New Words 
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PowerPoint is supplied with a variety of presentation designs that 
you can use in your presentations. You can either use them 
directly, without any change, or you can adapt them to your 
particular needs or taste, or to your company identity scheme. 

You can either create a new presentation using one of these 
designs, or you can apply a design to a presentation you have 
already created. 

To create a new presentation using a PowerPoint design, choose 
File | New. Then click the Design Templates tab, and select one of 
the designs: a preview of the design is shown on the right. When 
you have found one you want to use, click OK.  

 

To apply a design to an existing presentation, choose Format | 
Apply Design Template. Locate the designs folder (usually in 
c:\Program Files\Microsoft Office\Templates\Presentation 
Designs: the file names end in .pot). Choose the design you want 
to use. (To see a preview of the design, click the Preview button.) 
Click Apply. 

Exercise 6.18: Choosing a Design 
1) Apply a new design to the presentation previously created. Use the 

design called ‘Blends’. 

2) Save the presentation. 

3) Choose View | Slide Show, or click the Slide Show button. Move 
forward and back through the presentation to see how it would look to 
the audience.  

 

The design establishes a typographic framework for the 
presentation, and uses graphic devices (lines, colours, background 
images) to create an overall image. You can alter these to make the 
design your own. Rather than changing each slide individually, 

Using Presentation 
Designs  

Making the Design 
Your Own 

Preview button 
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you can make global changes – this saves effort and it helps make 
your slides consistent.  

 

PowerPoint has a number of built-in colour schemes. Each scheme 
consists of a set of eight co-ordinated colours.  

When you select a scheme, PowerPoint applies the different 
colours of the scheme to specific slide elements, such as title text 
(the text in the title placeholder), non-title text, background, 
graphic fills, and so on.  

Exercise 6.19: Applying a Colour Scheme 
1) Choose Format | Slide Colour Scheme. On the Standard tab, select 

one of the schemes. For this exercise choose the one with the blue 
background. 

 

2) On the Custom tab, select Text and lines and click Change Color. Pick 
a bright yellow. Select Accent & hyperlink, and change its colour to mid 
blue. Click OK. 

 

Modifying the Colour 
Scheme 
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3) Click Apply to All. This has the effect of applying the new colour 
scheme to all the slides in the presentation. 

4) Save the presentation. 

5) Click the Slide Show button, and move forward and back through the 
presentation to see how it would look to the audience.  

Colour Scheme 
A set of eight, preset co-ordinated colours you can use to give your 
presentation an attractive and consistent appearance. 

 

In the colour scheme, you can specify only a single background 
colour. If, instead of a flat colour, you want to specify gradients, 
textures, patterns, or pictures as the background to your slides, you 
can do so as shown below. Again, however, a word of caution: 
these options are intended to make your slides more exciting and 
dynamic; however, if you do not use them carefully, they can 
make your slides illegible! 

Exercise 6.20: Changing the Background 
1) Choose Format | Background.  

 
        As in the colour 

scheme, you can 
choose a single colour, 
either from the drop- 
down palette, or from 
the More Colors 
option. 
 
The more interesting 
options, however, are 
found in Fill Effects. 
 
Click this option. 

2) The screen shows four tabs 
– Gradient, Texture, Pattern, 
and Picture.  

In each, when you select an 
option, a sample is 
displayed on the lower 
right. Explore the options on 

Modifying the 
Background 
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offer. Then select the Gradient tab. 

3) Click the Two Colors button. Make Color 1 dark blue, and Color 2 light 
blue. Click the Horizontal shading style, and the first variant. Click OK. 

4) Click Apply to All. This has the effect of applying the new background 
to all the slides in the presentation. 

5) Save the presentation. Once again, take a look at the whole 
presentation to see how it would appear to the audience.  

 

Whether you know it or not, every slide you insert in a PowerPoint 
presentation is based on the style of the Slide Master. 

It is from the Slide Master that all slides take their default text 
formatting and positioning. In addition, anything that you insert on 
the Slide Master appears automatically on every slide of your 
presentation. This is useful for company logos or for graphic 
elements, such as lines and borders. 

To view the Slide Master, choose View | Master | Slide Master. It 
consists of two placeholders: 

■ Title Placeholder: 
Determines the format 
and positioning of text 
in every title 
placeholder in your 
presentation. 

■ Object Placeholder: 
Determines the format 
and positioning of text 
in every non-title  
placeholder. 

Notice that the Slide Master includes the graphic on the left-hand 
side. 

Your audience never sees the Slide Master; they see only its effects 
on the slides in your presentation.  

You can override the defaults supplied by the Slide Master on any 
individual slide. 

The Slide Master 
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Slide Master 
The Slide Master stores all the default attributes that you wish to 
apply to new slides, including text formatting and positioning, 
background, and standard graphics, such as your company logo.  

Exercise 6.21: Reformatting Text in the Slide Master 
In this Exercise, you change the text format of your presentation 
by changing the Slide Master. 

1) Choose View | Master | Slide Master and select all the non-title text 
in the lower placeholder. 

2) Choose Format | Font, and change the font of the selected text to Arial 
Bold. 

 

3) Choose View | Normal. Notice that the font of the text in all the non-
title placeholders of all the slides in your presentation has been 
changed. 

You can use the Slide Master to change other attributes of text in 
your presentation in exactly the same way: explore the options 
available in the Format menu, and in particular: 

■ Bullet, which allows you to choose the bullet character that 
applies to each level of text 

■ Alignment, which allows you to specify whether the text is to 
be ranged left or right, centred, or justified 

■ Line Spacing, which allows you to determine the amount of 
space between lines in a paragraph and between different 
paragraphs 

 

The Design, the Colour Scheme, and the Slide Master help you to 
establish rules that apply to all slides in a presentation. You can 
also, if you wish, break those rules on individual slides – you can 
make text bigger or smaller, change its font or style, change its 
alignment, or change the spacing between it and other text. 

Formatting Text on 
Individual Slides 
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To do any of these, first select the text you want to change. Then 
proceed as follows: 

■ To change the font, size, style (italics, bold, underline, 
superscript, subscript, etc.), colour, or effects, choose Format | 
Font, or click the relevant button in the Formatting toolbar 

■ To change the alignment of the text, choose Format | 
Alignment, or click the relevant button in the Formatting 
toolbar. 

■ To change the spacing between lines or paragraphs, choose 
Format | Line Spacing, or click the Increase Paragraph 
Spacing button, or the Decrease Paragraph Spacing button in 
the Formatting toolbar.  

 

■ To change the case of the text (initial capital, all lower-case, all 
upper-case, initial capitals on all words, or the opposite of the 
current selection), choose Format | Change Case, and select 
the option that you require. 

Exercise 6.22: Formatting Text on a Slide 
1) Open slide number 1 (New Product Launch) in Slide View. 

2) Click anywhere on the second placeholder to select it. Then drag the 
mouse across the text to select the text. 

3) Choose Format | Font and change the font to Arial, 72 point, bold.  

4) Enlarge the placeholder so that it is big enough to hold the text on a 
single line. 

5) Select the text again, and click on the Center Alignment button in the 
Formatting toolbar. Click the Shadow button in the Formatting toolbar 
and choose Shadow Style 5. 
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6) Save the presentation, and page through it to see the effect of the 
changes.  

 

Any object you draw or include in a slide has a border around it. 
Most of the time, this border is invisible (it has zero width), but 
you may want to change its width, colour or style.  

■ To change the width of the border around an object, select the 
object, then click the Line Style button in the Drawing toolbar 
and choose from the pop-up menu. 

■ To change the border around an object to a dashed or dotted 
line, select the object, then click the Dash Style button in the 
Drawing toolbar and choose from the pop-up menu. 

■ To change the colour of the border around an object, select the 
object, then click the Line Color button in the Drawing toolbar, 
and select from the Line Color pop-up menu. 

■ To delete a border around an object, select No Line in the Line 
Color pop-up menu. 

 

If you use PowerPoint’s built-in designs and colour schemes, your 
presentation will almost certainly succeed. However, you probably 
want to personalise it using some of the features described above. 
But the range of options is so vast that you could end up with a 
disaster. Here are some guidelines for success. 

 

As little as possible. Write economically, using headlines and 
bullets. Don’t give the audience the opportunity to read ahead: if 
you do, they won’t listen to you, and they won’t retain your 
message. If you are presenting information in bulleted lists, don’t 
have more than eight or nine bullets. If you must have more, 
divide them into logical groups and split them over several slides. 

Adding Borders to 
Objects 

Tips for Better 
Presentations 

How Much Should You 
Put on a Slide? 
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It depends on two things: the size of the screen on which the slide 
will be shown, and the distance from the screen to the back of the 
audience. Let’s say your slides will be viewed on a 4' high screen 
from a maximum distance of 32' (that is, eight times the height of 
the screen). Now measure the height of the slide as it appears on 
your computer screen: if it is 9'' high, you can pretend to be in the 
back row of the audience by looking at it from a distance of 6' (9" 
multiplied by 8). Choose your minimum point size by looking at 
your computer from this distance.  

The ‘eight times’ rule is actually a good guideline for most 
situations: if the room is larger, it is likely that the screen will be 
bigger. However, if in doubt, choose a bigger size: nobody ever 
complained that a slide was too legible, but many, many people 
have complained that slides were illegible.  

 

In general for projected images, choose a sans serif font, such as 
Swiss, Helvetica, Arial, Gill, ... (However, for large bodies of 
printed text, a serif font is generally recommended.) Typefaces 
vary in their legibility, and you might have to choose a bigger 
point size in certain fonts. 

 

Make sure that the colours you choose for text and background are 
sharply contrasting. You will find that reversed type (text in a light 
colour, background in a dark colour) is more legible. (The opposite 
is true of printed documents.) Remember that viewing conditions 
are often less than ideal, with lights shining onto the screen. A 
plain slide that can be read easily is much more valuable (to you 
and to your audience) than a fancy one that nobody can read. 

 

If you have created a style that you like, or that reflects your 
corporate colour scheme, you can save it as a template. Then, the 
next time you want to create a presentation, you can start with that 
template and all the slides will take on its characteristics. To do 
this, choose File | Save As. From the Save as type drop-down list, 
choose Presentation Template. You can give it a name other than 
that suggested, if you wish. PowerPoint Template files have the 
extension .pot. 

What Point Size Should 
You Choose?  

What Font Should You 
Choose? 

What Colours Should 
You Choose? 

Using the Same 
Style Again 
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PowerPoint contains a variety of presentation designs. These 
determine the overall look of the presentation. You can use them 
without change, or you can modify them to your requirements. 

You can modify the colour scheme used, the background, or the 
typography. 

The attributes of the design are held in the Slide Master. Any 
changes you make to the Slide Master are applied by default to all 
existing slides in the presentation, and to all new slides you create. 
You can, however, change text attributes on individual slides.  

You can also include graphic devices in the Slide Master: these 
will then be shown on every slide in the presentation. 

When you have tailored a design to your needs, you can save it as 
a presentation template. This enables you to use the same design 
in subsequent presentations. 

 

Section Summary: 
So Now You Know 
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Section 6.5: Building a Presentation 

In the previous Sections, you learnt how to create slides that will 
impress your audience. In this Section, you will learn how to 
assemble those slides into a convincing presentation, how to order 
and reorder your slides, how to insert and delete slides, how to 
make slides usable in other applications, and how to import slides 
from other sources. 

 

At the end of this Section, you should be able to: 

■ Reorder slides in a presentation 

■ Copy slides between presentations 

■ Delete slides 

■ Export PowerPoint slides to other applications 

■ Save presentations for use in other versions of PowerPoint 

Once again, the exercises in this Section are based on the 
presentation created in Sections 6.2, 6.3, and 6.4. Open the 
presentation before beginning the exercises in this Section. 

In This Section 

New Skills 
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Use Slide Sorter view to check that your formatting is consistent 
and that text placeholders are aligned. This is particularly 
important if you have made changes to the design or formatting of 
individual slides.  

Choose View | Slide Sorter. This shows you all the slides in your 
presentation on a single screen. (If they don’t all fit on your screen, 
use the scroll bar on the right.) 

To see or edit a particular slide in Slide View (full size), double-
click it. 

 

When you have created all your slides, you might decide that you 
want to present them in a different order, so that the ideas flow 
better. The easiest way to do this is in Slide Sorter view.  

You can reorder your slides in two ways: by dragging them with 
the mouse (better for small presentations), or using the cut-and-
paste commands on the Edit menu (better for large presentations). 

 

In Slide Sorter view, select the slide you want to move, drag it 
with the mouse so that a vertical line appears to the right of where 
you want to position the slide, and release the mouse button. 

 

You can cut, copy, and paste slides in PowerPoint as you would 
text in a word processor. 

In Slide Sorter view, select the slide, choose Edit | Cut (or hold 
down the CTRL key and press x). Click on the slide that will 
appear before the slide you are moving and choose Edit | Paste (or 
hold down the CTRL key and press v). 

Using Slide Sorter 
to Check Your 
Slides 

Changing the Order 
of Slides 

Reordering by Dragging 

Reordering with  
Cut and Paste 
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Exercise 6.23: Re-Ordering Slides 
1) In Slide Sorter view, use the dragging technique to reverse the order of 

slides 5 (Sales & Marketing) and 6 (Sales Projections). 

2) Use the cut-and-paste technique to make slide number 7 (Product 
Identity Scheme) appear after slide number 2 (Amazing Features). 

Note that the slides are renumbered to represent their new order: 
we will refer to them by their new number from now on. 

 
 

Just as you can cut a slide from one part of a presentation and 
paste it into another part, you can also cut (or copy) a slide from 
one presentation and paste it into another. Try it. 

Exercise 6.24: Copying a Slide from One Presentation to 
Another 
1) Open Dale Carnegie’s Presenting a Technical Report, as in Exercise 6.1. 

2) In Slide Sorter view, select slide number 3. 

Copying Slides 
between 
Presentations 
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3) Copy the slide by choosing Edit | Copy (or hold down the CTRL key 
and press c). 

4) Close Dale Carnegie’s presentation. 

5) Open your own presentation in Slide Sorter view. Select slide number 1 
(Launch of New Product), and choose Edit | Paste (or hold down the 
CTRL key and press v. 

The copied slide appears as slide number 2 in your presentation. 
Note that, while the content of the slide is exactly the same, the 
format has changed to agree with the design and layout of your 
presentation. 

 

 

If you want to remove a slide from your presentation, simply cut 
it, as described above, but don’t paste it. 

You can also delete a slide in any view, with the exception of Slide 
Show view, by choosing Edit | Delete Slide. 

Exercise 6.25: Deleting a Slide from a Presentation 
1) Delete the slide that you copied into the presentation in Exercise 6.24. 

2) Save the presentation.  

Deleting a Slide 
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In general, you should not have to enter information into one 
software application and then subsequently enter the same 
information into another application. For example, when you 
create your PowerPoint slides and you want to use the same text in 
a report you are writing in Word, you should not have to type it 
again. 

You don't. 

■ To use text from a single slide, copy the text in PowerPoint 
(select it and choose Edit | Copy), and paste it in Word 
(position the cursor and choose Edit | Paste). 

■ To use the text of the whole presentation in Word, choose File | 
Save As. From the Save as type drop-down list, choose 
Outline/RTF.  

 

If you wish, specify a file name other than the one suggested 
(the same as the presentation, with the extension .rtf).  

■ Click Save. 

If you want to use the slides in other graphic programs, or in web 
pages, you should save them in one of the graphic formats: either 
JPEG File Interchange Format, or GIF. Try it. 

Using PowerPoint 
Slides in Other 
Applications 
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Exercise 6.26: Making Slides Viewable in a Web Browser 
1) Choose File | Save As. From the Save as type drop-down list, choose 

GIF. Click Save. Note that you can save a single slide or the whole slide 
show. For the exercise, specify a single slide. 

2) Minimise PowerPoint and open the web browser on your computer 
(typically Microsoft Internet Explorer or Netscape Navigator). There is 
no need to connect to the Internet: open the program offline. 

3) Choose File | Open (Microsoft Internet Explorer), or File | Open Page 
(Netscape Navigator). Locate the .gif file you created in step 1 and click 
Open. 

4) Check that the slide appears correctly in your browser, and then close 
the browser. 

 

Each version of the PowerPoint software includes features that 
were not available in earlier versions. This means that, while you 
can generally use a later version of the software to open, view, 
edit, and save a presentation that was created in an earlier version, 
the reverse is not true. 

If, in PowerPoint 2000, you save a presentation that was originally 
created in PowerPoint 95, PowerPoint 4.0, or PowerPoint 3.0, it 
will be saved in its original format, unless you choose File | Save 
As and specify a different name, a different folder, or a different 
software version.  

If you want a presentation you have created to be viewable with an 
earlier version of PowerPoint, you must choose File | Save As and 
specify the software version in the Save as Type box. Note that 
some of the effects that you can specify in PowerPoint 2000 will 
not display properly in earlier versions of the software. 

Working with 
Earlier Versions of 
PowerPoint  
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Once you have created a presentation, you can change the order of 
slides. The best way to do this is in Slide Sorter view, where you 
can either drag the slide to its new location, or cut and paste it. 

You can copy slides into your presentation from other PowerPoint 
presentations. When you do, they take on the design and layout of 
your presentation. 

You can use the text of your presentation in another application, 
such as a word processor, either by cutting and pasting, or by 
saving the file in .rtf format. 

You can save individual slides or the whole presentation in .jpg or 
.gif format: these formats can be used in graphic programs and in 
web pages. 

And if you want your presentation to be viewable in an earlier 
version of the software, you have to specify this when you are 
saving the file. 

 

Section Summary: 
So Now You Know 
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Section 6.6: Wowing the Audience 

In this Section, you will learn how to make your presentation more 
dynamic, by using animations and transitions. You will learn how 
to prepare handouts for the audience, and notes for the presenter. 
And you will learn a few tricks that you can use when delivering 
your presentation. 

 

At the end of this Section, you should be able to: 

■ Specify transition effects 

■ Create build slides 

■ Add sound effects to slides 

■ Prepare handouts for your audience 

■ Number slides 

■ Prepare speaker notes 

■ Check the spellings in your presentation 

 

At the end of this Section you should be able to explain the 
following terms: 

■ Slide transition 

■ Build slide 

The exercises in this Section add professional polish to the 
presentation created in the earlier Sections of this Coursebook. 
Open the presentation before beginning the exercises in this 
Section. 

In This Section 

New Skills 

New Words 
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A transition is a graphic effect that determines how one slide 
replaces another – for example, the new slide could appear to drop 
down from the top of the screen, or the old slide could be made to 
dissolve, leaving the new slide. 

PowerPoint lets you control two aspects of a transition: 

■ Effect Type: The nature of the special effect with which 
PowerPoint introduces the slide. 

■ Effect Timing: The speed with which PowerPoint runs the 
visual effect when introducing the slide. 

You can also specify that you want a sound to accompany the 
transition. 

Transition 
A visual effect, such as a box-out, dissolve, or fade, that determines 
how one slide in a presentation is replaced by another. 

Exercise 6.27: Applying a Transition to Your Presentation 
1) With any slide open in Slide View, click the Slide Show button on the 

toolbar and choose Slide Transition. 

2) First explore the options on offer: 

• Effect: Each time you click an option from the drop-down list, 
PowerPoint runs the effect in the sample picture. You can rerun 
the preview by clicking the picture. 

• Timing: The options – Slow, Medium or Fast – set the speed at 
which the transition effect runs. Click an option and PowerPoint 
runs the effect with that timing in the sample picture. 

For the exercise, select the effect called Dissolve, with Fast Timing. 

3) Click Apply to All. Note that you have the option of applying a different 
transition to each slide (by clicking Apply), but be careful: this may 
have the effect of distracting or unsettling your audience.  

4) See how the transitions affect the presentation by choosing View | 
Slide Show and paging through the presentation. 

 

You can choose to have your presentation advance from slide to 
slide: 

■ On command (as described in Section 1) 

■ Automatically, based on specified timings 

■ Either, whichever comes first 

Slide Transitions 

Automatic or Manual 
Advance 

Transition Options 
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This is also specified in the Slide Transitions dialog box. The two 
effects are independent, however: you can automate the running of 
your slide show without applying a transition, and you can apply a 
transition without automating your slide show. You should also 
note that the timings have nothing to do with one another: the 
effect timing (Slow, Medium, Fast) relates to the speed of the 
transition from the previous slide; the automated advance time 
specifies how long the slide is displayed before being replaced. 

Automatic advance is often used in presentations that are left 
running in public areas, such as trade shows, where they are not 
accompanied by a speaker. 

 

Build slides allow you to reveal the information on a slide 
gradually. They are typically used for bulleted text: when you first 
show the slide, the audience sees only the first bullet. You then 
reveal the remaining bullets, one-by-one, as you talk to your 
audience. This has the advantage of keeping your audience 
engaged with what you are saying, rather than having them read 
ahead while you are still talking about the first point.  

Build Slide 
A slide in which different elements are revealed at different times.  

With a build slide, you can highlight each point in turn, to focus 
your audience’s attention. When you are talking about your second 
point, you can leave the first one on the screen, but dim it, so that it 
still serves as a context and reminder, but doesn’t distract. 

You can also control how each new element arrives on the screen 
– for example, bullet points can fly in from the right, left, top, or 
bottom. Let’s try it. 

Exercise 6.28: Applying a Build to a Slide 
1) Display slide number 2 (Amazing Features) in Slide View. 

2) Click anywhere in the lower placeholder, where the bulleted text is.  

3) Choose Slide Show | Preset Animation and select the option called 
Flying. 

 

4) Choose View | Slide Show to see the effect. Remember you have to 
click for each bullet point to appear. 

Build Slides 
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5) With the lower placeholder still selected, choose Slide Show | 
Custom Animation. 

Select the following settings: 

• In Order and Timing, make sure the bulleted text (Text 2) is 
highlighted and choose Start animation On mouse click 

 

• In Effects, choose Dissolve, No Sound, Light blue, All at Once, 
Grouped by 1st level paragraphs 

 

• Ignore Chart Effects and Multimedia Settings. 

6) Again, choose View | Slide Show to see the effect. 

Exercise 6.29: More Complex Builds 
1) Display slide number 3 (Product Identity Scheme) in Slide View. 

2) Choose Slide Show | Custom Animation to display the Custom 
Animation dialog box. 

In the Order and Timing tab, select in turn each of the three circles 
(called Ovals) and the bulleted text. When you select an object, it is 
highlighted in the preview screen. For each of these objects, click the 
Automatically button and specify 1 Second after previous event. 
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The names of the elements are transferred to the Animation Order 
box.  

3) Click Preview to see how the slide will be presented. 

4) Check that the elements in the Animation Order box are in the following 
order: first the three ovals, biggest first, smallest last, then the text. You 
can change the order by selecting the name of the object you want to 
change and using the arrow buttons to move it up or down. 

5) Select each of the ovals in turn and, in the Effects tab, specify Fly from 
Bottom-Right, No Sound, and Don’t Dim. 

 

6) Select the text, and in the Effects tab, specify Wipe, Down, No Sound, 
Don’t Dim, and All at Once.  

Click Preview to see the effect. 

7) Click OK to close the Custom Animation dialog box. 

Exercise 6.30: Grabbing Their Attention 
1) Display slide number 1 (Launch of New Product) in Slide View and 

choose Slide Show | Custom Animation.  

2) Select the text in the lower half of the screen (Text 2), and specify that 
it is to be animated Automatically, 1 Second after previous event. 

3) In the Effects tab, specify Spiral, No Sound, Don’t Dim, and All at Once.  



 

ECDL 3: The Complete Coursebook  6-59 

 

Click Preview to see the effect.  

Experiment with the alternatives to All at Once – By Word and By 
Letter – and each time click Preview to see their effect. 

4) Click OK to close the Custom Animation dialog box. 

Exercise 6.31: Animating a Chart 
1) Display slide number 6 (Sales Projections) in Slide View and choose 

Slide Show | Custom Animation 

2) In the Order and Timing tab, select the chart (Chart 2) to animate it, 
and specify Automatically and 1 Second after previous event.. 

3) In the Chart Effects tab, specify By Series, Animate grid and legend, 
Appear, No Sound, and Don’t Dim.  

 

It may be difficult to see the effect of this by using the Preview 
button, so click OK, then choose View | Slide Show and go through 
the presentation from the beginning.  

Exercise 6.32: On Your Own 
1) Animate slide number 4 (Advantages and Disadvantages) so that the 

advantages appear one at a time, flying in from the left, and the 
disadvantages appear one at a time, flying in from the right. 

2) Animate slide number 5 (A First Look at the New Product) so that the 
features appear one at a time, flying in from the right. 
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If you followed the exercises above, you specified No Sound each 
time. If you were adventurous, you probably tried out some of the 
other options. If you didn't, try them now: you can choose a sound 
to accompany each transition and each animated effect. There is a 
wide range of sound effects available: the most commonly used 
are already listed in the Sound drop-down list. You can find others 
by choosing Other Sounds and selecting any file that has the 
extension .wav. 

 

You can, if you wish, simply print out your slides and distribute 
them to your audience. However, this is somewhat inelegant: the 
size of type that is appropriate for a slide is much too big for 
normal reading. Instead, PowerPoint gives you the option of 
producing handouts in which several slides are shown to a page.  

To do this, choose File | Print, choose Handouts from the Print 
What drop-down list, and specify the format you want to use. 

 
 
 

When people in your audience ask questions, they may want to 
refer to a specific slide, so it is useful to identify each slide by 
number.  

Exercise 6.33: Adding Slide Numbers 
1) Choose View | Header and Footer. 

2) In the Slide tab, check Slide Number. Leave the other options 
unchecked. 

3) Click Apply to All. 

Note that this tab also enables you to include the date and time on 
each slide. 

If you choose similar options on the other tab – Notes and 
Handouts – the page number (or date and time) will be shown only 
on the handouts and speaker notes, but not on the slides 
themselves. 

Music and Other 
Noises 

Preparing Handouts 

Numbering Your Slides 
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Remember that if you want to display a particular slide in Slide 
Show view, just type the slide number and press ENTER. 

 

If you wish to write a script to accompany the slides, or simply 
make notes to remind you of the key points or additional 
background information, you can use the speaker notes facility. 
This enables you to create a document with one page for each 
slide. The slide is shown in the top half; you enter your notes in the 
bottom half. (PowerPoint does not display the notes on screen as 
part of your presentation.) 

You can enter text to your speaker notes pages at any stage when 
creating or editing your presentation. 

Speaker Notes 
A document which has one page for each slide in the presentation. 
Each page is divided into two: the slide is shown at the top, and 
speaker notes are shown at the bottom. 

 

To enter, edit, or view speaker 
notes, choose View | Notes 
Page.  

To enter or edit text, click on 
the text placeholder.  

By default, PowerPoint 
displays a notes page at 40% 
of its full size. You may wish 
to increase this to nearer 100% 
when typing or editing. Do 
this by choosing View | Zoom. 

To print out speaker notes, 
choose Print, and from the 
Print What drop-down list, 
choose Notes Page.  

 

Spelling mistakes really spoil a presentation: they make you look 
either careless or ignorant – and your effort to impress the 
audience may be wasted. While it is dangerous to rely totally on a 
spell-checker, it is also foolish not to use one at all. 

To use the spell-checker, choose Tools | Spelling, or press F7. Any 
words that fail the spell check are shown, with suggested 

Speaker Notes  

Notes View 

Check Your Spelling! 
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alternatives. You can accept one of the suggestions, edit the word 
yourself, or leave the original unchanged. 

 

Note that the spell checker will not find incorrect spellings that are 
themselves valid words (such as ‘form’ instead of ‘from’). 

 

You already know how to use Slide Show view to start your 
presentation. Another option is to save the presentation as a slide 
show, so that it always opens as a slide show, whether you open it 
within PowerPoint or directly from the desktop. To do this, choose 
File | Save As, and specify PowerPoint Show. The file will be 
saved with the extension .pps. 

Saving Your 
Presentation as a 
Slide Show 
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You can control the way a new slide replaces an old one with 
transition effects; these can be as conservative or as dramatic as 
you like. In addition, you can add sound effects to the transition, so 
that the new slide arrives with an explosion or a clash of cymbals. 

To hold your audience’s attention, you can reveal the material on a 
slide piece-by-piece, in a build slide. Build slides can be animated 
in a variety of ways. 

You can prepare handouts for your audience, with several slides to 
a page, and you can prepare speaker notes, with the script that you 
want to follow, or additional details to support your presentation. 

You can number slides for easy reference, and you can check the 
spelling on all your presentation materials. 

Finally, you can save your presentation as a slide show, so that it 
will always open in Slide Show view. If you do this, the file will 
have the extension .pps. 

 

Section Summary: 
So Now You Know 
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